A THE
'\\%D B DT FIUCIICCS

N F errmesatiamre  COURSE TRANSCRIPT

Hello, this is Eric Bobrow. And in this lesson, we'll take a look at how you can do some initial program
planning to calculate the number of spaces you have and their total areas.

So here | have a small building laid out, and I'm going to use the Fill tool. With the Fill tool, we can go
and manually draw a shape like this, but I'll cancel that and use the Magic Wand. So | will press down
the space bar and get the Magic Wand and then click. That will then find the boundaries around the
area that I'm clicking in, and then when | put the hammer down, | will place the area reference. That's
because I've got the setting as | showed earlier to show area text active. So I'll go ahead and do this for
the other spaces here. [0:00:55]

And then | will go and change the colors to demark different usage. So I'm going to be fairly arbitrary
here and pick a different color for this one, and pick a third color for these. So now we can see what all
of these are different usage areas. And perhaps I'll create one more that will go for - let's just imagine
that the site is this bounded area. Now that particular fill went across over the top of all the other fills,
so I'm going to right click on it and use the Display Order, Send to Back, and then we will see it behind
the other ones. [0:02:04]

Now we can manually write down these numbers, and of course transfer them to a spreadsheet. But
ArchiCAD does give some options for totaling these up. Let's look at an Interactive Schedule. So the
schedules that we have in the standard template that include anything that would total up the fills, so
I'm just going to open up any of them just to bring up the schedule window. So I'll double click on one of
them and then click on Scheme Settings. And when | do that, that allows me to look at different Scheme
Settings that exist or to create a new one, which is what I'll do. [0:02:41]

And | will create one that will just be called "Area Fills". So this is going to be reporting on the area of
the various fills that I'm placing. The first thing | needed change is under the criteria to say | need to
look at fills. And | can close this up and look down below. And you'll see in the general section, | can pull
over the area and perhaps the fill and perhaps we can do the ID. And we'll take a look at what that gives
us. [0:03:17]

So I've just pulled over three of the options in the general. If we look under fills specifically, there are
actually not a lot of good choices for this. In other words, the information here is not going to be very
useful. We're really mainly interested in the area. So I'll just go ahead with this one and say OK. So now
you can see that it shows the area fills. We can see some of the square footage, the area reported. Now
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the fills are all the same type, because | just use a poché of 25%. So that's actually not very useful. And
the IDs, well those are the internal reference numbers; they're not really telling me very much. [0:04:04]

So let me go ahead first of all and take out the fill here. | will just highlight this and click remove and say
OK. And then we'll go back to the plan. I'll just hit F2 to go back to the plan and select these 3 fills here
and go in the Info box and change the ID there. The default ones that were filled in by ArchiCAD. I'm just
going to call these "Classroom". And then I'll go and call this one "Meeting". And let's imagine that
these two at the end are actually restrooms. So I'll just give them a symbol designation of the "WC".
[0:05:02]

Now if | go back to the report, you'll see that now it makes a little bit more sense. And of course | could
call them "Classroom 1, 2, 3" or whatever. But let's look at how this could be totaled perhaps. Soif | go
to Scheme Settings, | can say next to the area, | can click on the little space next to the down arrow, and
click on the Calculate button that will sum it up. And perhaps let me move the IDs up to the beginning.
I'll grab them on the left side and move the IDs up. And we don't need to sum those up, so | will keep
clicking until this becomes blank. [0:05:58]

So now it's going to sum up the area but it will show the ID which is the usage type at the beginning.
And now you can see its totaling things up, let me just widen this area so we can see it. However, we
can see that it's including the fill that is the overall area for that site. Perhaps | don't want to include
that. So how would we leave that out? | can go under the Scheme Settings, and under the criteria - let's
see this criteria says "Fill 13". So let me go add a criteria here that the element ID - this is just one of the
ones that we can pick from, but it happens to be the correct one - | will say it's not, and we will type in
"Fill 13" I think that was the one, let's just see, Fill 13, yes. [0:06:56]

So then | will just say OK and you'll see that it leaves that out. So now we're getting a report of just the
ones we want. So this is one way that we can get this information. | can go to the File menu and say
Save As, and you'll see that when I'm in the schedule here, one of the options is to save it as an Excel
file. In fact, we will see that it basically limits me to Excel or tabbed text or just essentially a visual image
of what I've got, PDF or DWF. So we could export that to Excel. [0:07:32]

Now let's take a look at another alternative where we have some more flexibility, which would be the
Zone tool. So I'll go - with the Fill tool active - | will go and select all of these fills and delete them. And
let's start over with the Zone tool. So when I click the Zone tool, you recall that | can put in zones
manually or | can tell it to go find the boundary. And that is pretty much the same as using the Magic
Wand that | did it with a fill. So if | go click in the middle of the zone and drop in the stamp, you'll see it
finds the area. [0:08:10]

The zone stamp is really tiny for our purposes at least, so I'm going to go in and open up the settings and
tell it to make the text much bigger here, so that we can see it onscreen. So you can see now that it's
much easier to read for our training purposes. And I'll use the eyedropper to pick up the settings of that
so that | can go and place the next one in, and it will be similar. Let's see, | didn't quite get it. Let's get
the eyedropper on this, and we'll use the syringe to inject it. There we go. So the eyedropper
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remembers the Option or Alt key, and you can see that the eyedropper comes up. And if | want the
syringe it's Option+Command or Alt+CTRL, and that will give you the syringe and inject the settings from
whatever you have picked up. [0:09:10]

So | will go ahead and put in the other rooms and then we'll change their designations momentarily. So
these rooms have numbers. So you can see one, two, three, four. Because | used the eyedropper, three
of them have the same number the same number one. They also are showing the areas. Now I'm going
to go ahead and let's say designate these by different usage. So I'll select this zone and we'll change it
from this designation, "conditioned space", and | will change it here. We could name these differently,
these are available under the Options menu, | will just show you Options, Element Attributes, Zone
Categories, and it's in this area that you can actually define the name. For example, we can rename any
of these categories. [0:10:09]

We can also change the color. You can see if | double click on the color | get the option to change that.
And we can see that we can work with any of these and create new ones or rename and as we see fit.
And you can even set up some of the default values if you want to change the size or what's turned on
or off in terms of these parameters for each category. [0:10:36]

So | won't make any changes right now. I'll just go ahead and select these two and we'll put them in a
different category here. | just wanted to get them color coded so that they visually stand out. So we
don't have a report on the zones right now. | will go in again and let's say just open up the Area Fill
report. 3. Now the Area Fill, there are no areas anymore, because | deleted all of the fills. So let me go
to the Scheme Settings and we will create a new one. So I'll just say - | could say Duplicate. Let's just see
what happens if | say Duplicate This and call it "Area Zones". [0:11:21]

And now it starts out the same, but we do want to make sure that it's not looking at fills, in fact, that it's
looking at zones. And we don't need the element ID restriction here. So let me remove that. Now,
down below, you can see that ID is still available and area. But in the zones, we actually have some
more useful things. For example, we may want to bring over the zone category, which has to do with its
use. | will just drag it right up to the top so you can see that it will be listed first. And perhaps we want
the zone number. And we may not actually want the ID, because the ID is sort of arbitrary. But let's just
see what happens when | say OK. [0:12:07]

So you'll see that now we've got a listing. | will go and let's say widen some of these to make sure that
they don't wrap the text here. And let me close off the formatting on the left side. So there is a little
triangle that | clicked that allowed me to say focus on just the report as opposed to the formatting of the
report. So now we're seeing the list of categories. We have the IDs, which happen to be similar to the
zone numbers. But the zone numbers would be typically what you would display in terms of a room
number on the plan. So we might actually turn off this ID here. [0:12:55]

And here we have similar types of area reporting. So let me go and turn off the ID. So just highlight this
one and click remove. But I'll also say, "What if we wanted to total up not just the whole thing but to
total it up by category?" So | can go into the third section here next to the field name, and you can see

3 Best Practices Course — Week 11 Part 2 — © copyright 2012 by Eric Bobrow



this little flag that when | click on it, it will go on or off. This says grouped by category. When | say OK,
you will see that now it's showing a subtotal for, in this case, the conditioned space and then for the
garage or whatever we're talking about. And then it's still showing the total nicely. So this certainly is
giving me more information. [0:13:44]

Let me just abbreviate this so that way | can make this a little bit narrower. And | will reopen the
formatting on the left side. And we'll see that one of the options is to Show a Headline. And so if | show
a headline here, then it takes what was previously all of the same names being repeated. | will turn this
off and you'll see. So instead of repeating these all, if | say show a headline, then it will just group them
one by one. So that's actually a pretty, nice, clear way of reporting. Another option is to Show Uniform
Items as a Single Entry. And when | highlight that, you can see some simplification of the display. But
I'm not really sure that that helps, because actually the numbers here are useful. So | think that
probably just showing the headline is the best way to report it. [0:14:47]

And again we can go to the File menu and say Save As, and we could save this as an Excel file. Let's just
do that here. | will save it, and then open it up. | will go to - it says Area Zones.xls, so | double click on
that. And it should bring up Excel. And then we should see something pretty similar. So obviously if you
have a very complex building this may be a lot of information, and you may want to analyze it in
different ways. Put in costing or other information related to it. So you can see that the Excel file here,
I'm in Excel and it looks much the same as what | had. It has the same information here as we were
looking at a minute ago in ArchiCAD. [0:15:37]

So the final thing | want to show is what happens when we're working on this and we want to tighten up
some of the distances or locations of things? So for example, | just sketched this out, but | will use the
Marquee tool and say, "What if | wanted to make sure that the overall depth of the building from front
to back was a certain dimension?" Because | just sketched it, and it probably isn't that. So I'm going to
go with the Marquee tool and draw a marquee around the whole upper area of the building. And then
with the Marquee tool still active, | will position my mouse right at the corner. And you'll see | get a
checkmark as usual. When the Marquee tool is active and you click on something where you have a
checkmark or Mercedes, it is implicitly a stretch command. [0:16:34]

So I'm going to go click on this and - let me just actually stretch it up a little bit, and you can see with the
tracker I'm going on the axis, going 90°. And I'll just stretch this up. You can see how within a few
seconds it updates and stretches the walls that were partially enclosed, and it moves the wall that was
fully enclosed. And of course the zones all stretched. Now you remember the zone square footage is
not going to update until we use the zone update command. So the update zones command. Now if |
want this to be a specific length, of course | could do this and | could type in a value. In other words, |
could say that | wanted to be a distance of one foot longer. [0:17:20]

But what if | wanted it to be a certain distance from the other end? That would be a natural option. So |
will click here, go down to this end, and it says right now, moving down to the other and I've moved 41
feet and a fraction. So let's say | wanted this building to be exactly 40 feet in length. So what I'll do is
type in 40-0, because that will be 40 feet and no inches, and then I'll type in a minus. And what that
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does is it says subtract from the value that was just showing, and that amount, that 40 feet. And so it
says, "Well, you would need to move one foot three and a fraction inches to get it to be this distance
away". I'll hit the Enter key, and you can see that it adjusts slightly. [0:18:11]

Now to verify that it really is the right length, I'm going to use the Measure tool here. And I'll just click
on this end and click on the other end here. And you can see that it says 40 feet. So I've just made
exactly 40 feet. I'll hit the Esc key to cancel the measure. Now suppose | wanted to make this actually
42 feet or something like that. Well with the Marquee tool still active and the marquee around this
area, | can go down. And instead of typing in a subtraction let's say 35 feet to say | want to make - it will
go down, | will type in 42 feet 6 for example, and type in a minus. And that will say it will go back the
other direction the right amount. [0:19:02]

And | hit Enter or Return. And you can see that it has moved up. And this will be exactly the 42 feet 6
inches. That's about 14 meters | guess. So we can get it to be any length that we want. Now let me just
take this for the side of the building instead. and so | will go and click and say that | want to measure this
from this point here and say that | want this room to be a certain size. Now actually I'm measuring from
the outside of the room, so let me cancel this. | will hit the Esc key. And let's say | go from the inside
corner. And I'll go from the inside corner to the other inside corner and | want this room - its showing as
13 feet 11. Let me make it exactly 15 feet. So | will say 15 and I'll do minus. Now if | was going to type
ininches, then | would type in 6 or some number of inches at this point. [0:20:00]

But if | don't have any inches, | will simply type in an extra minus. And it will then move back that
amount. So if you're in the metric system, you don't have to worry about that, you just type in either
whole meters or millimeters on centimeters in that case. But what I've just done, and I'll just measure,
I'll hit the M key to open up the Measure tool, and I'll measure across from here to here, you can see the
15 feet. So what I've just done is actually changed the dimension of the entire configuration based on
this corner and the distance that it is from the other corner. [0:20:37]

So obviously this is a very powerful thing. We can adjust anything we want with this marquee. The
simplest is when you use the rectangular marquee, where it just is going to affect things on the axis. But
of course you can use the marquee with other shapes. We have the options of doing irregular shapes or
even a rotated rectangle if we want. So if | just want to make this room on the left a certain size, | can
go and click at that inside corner, don't click, and just position it over that. It says it's 17 feet something.
I'll just type in that | want it to be 16. So | will do 16 minus minus, that will mean 16 feet 0 inches to
going back. And this will now make that room exactly 16 feet across. [0:21:27]

Now remember all of these areas, they look like they're correct, but they actually have not been
updated. So if you're using zones, remember that one of the things you need to do is go to the Update
Zones at some point and say Update All Zones or perhaps selected ones, and you can see how they all
have changed in terms of their values. So this concludes the lesson on program planning using fills and
zones to create areas and spaces and list the rooms and areas to see how they compare to your program
requirements. And then the little extra section that | did of showing how to adjust a sketched out
configuration in order to get elements to be exactly a specific distance after the fact. [0:22:27]
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This is a great shortcut for allowing you to tighten things up and make them nice nominal even
measurements after you perhaps have done things a little bit more loosely and just done them by eye.

So this has been Eric Bobrow. | look forward to your comments and questions on the page down below.
Thanks for watching.

[END OF AUDIO 0:22:54]
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